
“Going Tech Crazy for the U.S. Symbols”

n PROGRAM OVERVIEW 
My goal everyday as a teacher is for 

my students to want to come to school 
and learn. It is not only my job, but my 
responsibility to teach every one of my 
students and address every challenge, 
whether it is an academic challenge or 
behavior challenge. I love turning things 
in my classroom into a fun project or 
game. I cannot expect my students to 
have fun or enjoy a subject or topic if I 
am not enjoying it myself. 

My program not only teaches 
students about different symbols of our 
country, but also how to use technology 
in an innovative and creative way to 
make school projects more appealing 
and interesting.  

“Going Tech Crazy for the U.S. 
Symbols” was designed for my students 
in first grade but can easily be adapted 
to fit any grade level. Students will 
learn about U.S. Symbols through 
Discovery Education videos, Power 
Point presentations using Hidden Picture 
template, Talking Books using Power 
Point, and the use of MP3 players. 

The assessment procedures include 
a pre-test and post-test matching the U.S. 
symbols to the proper word and multiple 
choice questions.  They will also learn 
about the Pledge of Allegiance and be 
assessed on the proper etiquette when 
reciting it. Through the use of the MP3 
players students will record themselves 
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saying the Pledge of Allegiance and 
listen to their own recording. They 
will then time themselves using a 
stopwatch and record their progress 
on a log. The purpose of this activity 
is to practice reading fluency. Power 
Point presentations will be created in 
collaborative groups using the Hidden 
Picture template and Talking Books 
addressing the American Flag, Bald 
Eagle, the Statue of Liberty and the 
Liberty Bell. Using a rubric the students 
will be assessed on a final Talking Books 
Power Point presentation.

“Going Tech Crazy for the U.S. 
Symbols” was designed for students 
in grades K – 2 but can be adapted for 
any grade level. Most of the student 
population at my school consists 
of ESOL students and/or students 
that come from a low socioeconomic 
background. I have eighteen students 
in my classroom. Five are reading at 
or above grade level. Twelve are below 
grade level and one is still trying to 
master her letters and sounds due to 
language (ESOL). Nine of my students 
are ESOL and one is ESE. 

By utilizing technology in the class-
room all students can learn! No matter 
what obstacles a student may have using 
technology makes learning just a little 
more easy and a lot more fun!

n OVERALL VALUE 
The overall value of this program is to 

teach students to have an understanding 
and appreciation for the country that 
we live in. When you use creative and 
innovative ways to teach students about 
a particular subject they enjoy it more! If 
students are engaged and are interested 
in what they are doing it assists them in 
retaining the material in a more effective 
way. 

We are moving more and more to 
a world that uses technology in every 
aspect of our lives. “Going Tech 
Crazy for the U.S. Symbols” gets 
children familiar with various aspects of 
technology and how to use it effectively 
and efficiently. Many of my students 
have difficulty in reading and have 
language barriers. 

I have found that through the use 
of technology my students are very 
receptive to exploring, learning and 
retaining new ideas. 
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“Going Tech Crazy for the U.S. Symbols”

n LESSON PLAN TITLES
• Lesson 1 – Week 1
	 Symbol?	What’s	a	Symbol?

• Lesson 2 – Week 2
	 Can	You	Hear	Me	MP3?

• Lesson 3 – Week 3
	 U.S.	Symbols	and	Hidden	Picture

• Lesson 4 – Week 4 & 5
	 Talking	 Books	 and	 Our	 U.S.	

Symbols

• Future Idea for a Follow-Up Activity/
Lesson

	 Web	Cam	Book	Buddies

n MATERIALS 
Materials for each lesson are listed 

with each lesson plan.  Overall materials 
budget including pricing and vendors 
follows the lesson plans.

Students Working on Hidden Picture

n ABOUT THE DEVELOPER 
Sharon Lynn Francis earned her 

B.A. in Criminology from the University 
of South Florida in 2001. She worked 
as a Juvenile Probation Officer for three 
years before making a career change to 
the field of education. 

Sharon has been a f irst grade 
teacher at Snively Elementary School 
of Choice for five years. She is a Florida 
Digital Educator and enjoys being a 
technology coach at her school. She is 
currently working on her Masters degree 
in Curriculum and Instruction and will 
graduate in March 2010.
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n SUBJECTS COVERED 
Social Studies and Technology

n GRADES
Kindergarten - Two

n OBJECTIVES 
Students will…

• develop an understanding of what 
a symbol is and how they are used 
all around us. 

• understand that a symbol is anything 
that stands for something else and 
that they can represent things that 
are too large to carry around, like a 
highway, or a symbol can represent 
things that are abstract. 

• develop an understanding about 
symbols that represent the United 
States of America.

n SUNSHINE STATE 
STANDARDS 

SS.1.A.2.1 Understand history tells the 
story of people and events of other 
times and places.  

SS.1.A.2.4 Identify people from the 
past who have shown character 
ideals and principles including 
honesty, courage, and responsibility.  
Examples are Presidents, war 
veterans, community members, and 
leaders.   

SS.1.C.1.2 Give examples of people who 
have the power and authority to make 
and enforce rules and laws in the 
school and community.   Examples 
are principals, teachers, parents, 
government leaders, and police

SS.1.C.3.2 Recognize symbols and 
individuals that represent American 
constitutional democracy.   Examples 
are United States flag, Pledge of 
Allegiance, National Anthem, Statue 
of Liberty, bald eagle, George 
Washington, Abraham Lincoln, and 
the current President.   

n MATERIALS 
•  Computer or Laptop

•  Interactive White Board

•  Projector

•  Internet

•  Dry erase markers

•  Dry erase boards

•  Pencils

•  Sentence strips

•  Copy of the Uncle Sam Hat

•  Glue

•  Stapler

•  Discovery Education videos “U.S.	
Symbols” and “Uncle	Sam”

•  Book – Our	Flag	Time	Readers	for	
Kids (Harcourt)

•  Book – The	Statue	of	Liberty	Time	
Readers	for	Kids (Harcourt)

•  Symbols	 of	 Our	 Country booklet 
(www.edhelper.com)

•  Teacher created word wall cards 
using Microsoft Word and images 
from www.yahoo.com

n VOCABULARY 
Bald Eagle, strength, freedom, American 
Flag, colonies, state,  Liberty Bell, 
Pennsylvania, England, Declaration 
of Independence,  Statue of Liberty, 
friendship, France, New York, immigrants, 
Francis Scott Key, Star Spangled Banner, 
Francis Bellamy, Pledge of Allegiance, 
George Washington, president, White 
House, Benjamin Franklin, Uncle Sam, 
United States

n DIRECTIONS 
1.  Hand out a pre-test assessing the 

students on what symbols of the 
United States they recognize and 
which ones they do not.

“Going Tech Crazy for the U.S. Symbols” Sharon Francis
Lesson Plan No 1: Week 1 - Symbol? What’s a Symbol?

2.  After the pre-test discuss that a 
symbol is anything that stands for 
something else.

3.  Preview – Read the books “Our	
Flag” by Joanne Randolph and “The	
Statue	of	Liberty” by Elena Martin                                                              

4.  Show the video “U.S.	 Symbols” 
and “Uncle	 Sam” from Discovery 
Education

5.  Divide students into teams of four.

6.  Give each group a white board, 
marker and eraser.

7.  As collaborative groups the students 
need to write down True or False to 
questions regarding the American 
Flag, Statue of Liberty, Bald Eagle, 
Liberty Bell and Uncle Sam relating 
to the videos.

8.  Provide students with a copy of the 
booklet Symbols	 of	 Our	 Country 
(www.edhelper.com)

9.  Provide students with a copy of the 
Uncle Sam print out and allow them 
to color it and cut it out

10. Give each student a sentence strip 
and allow them to glue their hat to 
the strip.

11. Staple each hat and allow the 
students to wear them while working 
on their projects.

n EVALUATION/
ASSESSMENT 
The pre-test will be graded. After 

watching the video “U.S.	Symbols” and 
“Uncle	Sam” from Discovery Education 
the students will be asked a series 
of statements. The students will be 
assessed informally on cooperation, 
knowledge of the symbols and which 
ones represent the United States using 
the white boards.
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“Going Tech Crazy for the U.S. Symbols” Sharon Francis
Lesson Plan No 2: Week 2 - Can You Hear Me MP3?
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n SUBJECTS COVERED 
Social Studies, Reading and 
Technology

n GRADES
Kindergarten - Two

n OBJECTIVES 
Students will… 

• record themselves saying the 
Pledge of Allegiance using the MP3 
Players. 

• develop an understanding that the 
Pledge of Allegiance is a promise 
of loyalty to the United States. 

• learn that Francis Bellamy wrote the 
Pledge of Allegiance.

• learn the proper etiquette of how to 
deliver the Pledge. 

• show an improvement with reading 
fluency by timing themselves and 
logging their progress. 

n MATERIALS 
•  Computer or Laptop

•  Interactive White Board

•  Projector

•  Internet

•  MP3 Players

•  Microphone

•  Headphones

•  Stopwatches

•  Copy of the Pledge

• Copy of a log to record their 
progress

•  Book - I	Pledge	of	Allegiance by: Bill 
Martin Jr. and Michael Sampson 

n SUNSHINE STATE 
STANDARDS 

SS.1.A.2.1 Understand history tells the 
story of people and events of other 
times and places.  

SS.1.A.2.4 Identify people from the 
past who have shown character 
ideals and principles including 
honesty, courage, and responsibility.  
Examples are Presidents, war 
veterans, community members, and 
leaders.   

SS.1.C.1.2 Give examples of people 
who have the power and authority 
to make and enforce rules and 
laws in the school and community.   
Examples are principals, teachers, 
parents, government leaders, and 
police

SS.1.C.3.2 Recognize symbols and 
individuals that represent American 
constitutional democracy.   Examples 
are United States flag, Pledge of 
Allegiance, National Anthem, Statue 
of Liberty, bald eagle, George 
Washington, Abraham Lincoln, and 
the current President. 

LA.1.1.4.8 The student will use self-
correction when subsequent reading 
indicates an earlier misreading.  

LA.1.1.7.9 The student will self monitor 
comprehension and reread when 
necessary.

   

n VOCABULARY 
American Flag, United States, Pledge 
of Allegiance, Francis Bellamy freedom, 
United States

n DIRECTIONS 
1.  Complete a KWL chart with the class 

of what they know and what they 
want to know about the America 
Flag.

2.  Read the book Pledge	of	Allegiance 
by: Bill Martin Jr. and Michael 
Sampson 

3.  Discuss what each part of the 
Pledge means using the book as a 
guide and the proper etiquette when 
addressing the flag.

4.  Provide each student with a copy 
of the Pledge of Allegiance and a 
reading fluency log.

5. Allow each student to record 
themselves saying the Pledge of 
Allegiance onto an MP3 Player.

6.  The students will then be able to 
listen to themselves reciting the 
pledge, follow along with their own 
copy and use a stop watch to record 
their time.

7.  As a class students will indicate 
on the KWL chart what they have 
learned. 

n EVALUATION/
ASSESSMENT 
Students will be assessed on using 

the MP3 Player, their ability to recite 
the Pledge of Allegiance as well as 
their progress on their reading fluency 
log. They will be assessed on their 
knowledge that when delivering the 
Pledge of Allegiance, all must be 
standing at attention, facing the flag with 
their right hand over their heart. 

H H H



“Going Tech Crazy for the U.S. Symbols” Sharon Francis
Lesson Plan No 3: Week 3 - U. S. Symbols and Hidden Picture
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n SUBJECTS COVERED 
Social Studies and Technology

n GRADES
Kindergarten - Two

n OBJECTIVES 
Students will… 

• use what they have learned about 
the Flag, Liberty Bell, Statue of 
Liberty and the Bald Eagle to create 
a power point presentation using a 
hidden picture template. 

• be able to explain what each one 
symbolizes, why they are important 
and the history of how they became 
symbols of the United States.

n MATERIALS 
•  Computer or Laptop

•  Interactive White Board

•  Projector

•  Internet

•  Flash drives

•  Power Point

•  Hidden Picture template (please 
e-mail me for the template)

•  Clip ar t (Microsoft Word) and 
images for www.yahoo.com

•  Discovery Education video “U.S. 
Symbols”

•  Notebooks 

•  Pencils

n  SUNSHINE STATE 
STANDARDS 

SS.1.A.2.1 Understand history tells the 
story of people and events of other 
times and places.  

SS.1.A.2.4 Identify people from the 
past who have shown character 
ideals and principles including 
honesty, courage, and responsibility.  
Examples are Presidents, war 
veterans, community members, and 
leaders.   

SS.1.C.1.2 Give examples of people 
who have the power and authority 
to make and enforce rules and 
laws in the school and community.   
Examples are principals, teachers, 
parents, government leaders, and 
police

SS.1.C.3.2 Recognize symbols and 
individuals that represent American 
constitutional democracy.   Examples 
are United States flag, Pledge of 
Allegiance, National Anthem, Statue 
of Liberty, bald eagle, George 
Washington, Abraham Lincoln, and 
the current President.

n VOCABULARY 
Symbol, freedom, liberty, American 
flag, Liberty Bell, Statue of Liberty, Bald 
Eagle Bald Eagle, strength, freedom, 
American Flag, colonies, state,  Liberty 
Bell, Pennsylvania, England, Declaration 
of Independence,  Statue of Liberty, 
friendship, France, New York, immigrants 
Francis Scott Key, Star Spangled 
Banner, Francis Bellamy, Pledge of 
Allegiance, United States

n DIRECTIONS 
Insert clip art as a Background

1. On the interactive white board 
show the students how to use the 
hidden picture template (e-mail me 
at Sharon.francis@polk-fl.net for 
the template).  

2. Click on the View Tab.
3. Choose Slide Master.
4. Be sure the blank slide is selected 

on the left task pane.
5. Click on the Insert Tab.
6. Choose either a picture or clip art 

icon and insert it into the slide.
7. Resize the picture to fit the entire 

slide behind the boxes.
8. Click on the View Tab and choose 

the Normal icon.
9. Once you see the picture on slide 

number 1 (the one without the color 
behind the blocks) delete it so when 
you start the activity the students do 
not see the hidden picture.

Duplicate Slide  
1. Duplicate the Slide that is covered 

with all the squares by clicking on 
the small slide on the left hand side 
and pressing the Control Key + D. 

2.  Delete one of the covered squares to 
reveal a piece of the background.

3. Next duplicate the slide with the 
missing piece and delete another 
square. Now you will have a slide 
with two pieces revealed. 

4. Continue this process of duplicating 
the slide and deleting a colored 
square until all 15 squares have 
been deleted and the complete 
background is revealed. 

5. Save the game to a flash drive.
In order for the student to reveal 

a piece of the background have them 
answer a question. In step four you can 
delete more than one square at a time 
if you want less than fifteen questions. 
Explain that the point of hidden picture 
is to ask a series of questions and take 
colored blocks away to begin revealing 
the answer. Divide the students into four 
groups. Each group will be assigned a 
symbol of the United States. The Flag, 
Liberty Bell, Statue of Liberty and the 
Bald Eagle. Give each group a flash 
drive. Any work will be saved on the flash 
drive which will be numbered 1 – 4. The 
groups may work on their projects first 
thing in the morning, during center time, 
during Social Studies and at the end of 
the day. Students may refer back to the 
Discovery Education video for reference 
(which is loaded on each computer in the 
room), books that have been introduced 
as well as their booklet Symbols of Our 
Country from www.edhelper.com.

n EVALUATION/
ASSESSMENT 
The students will be assessed 

on their Hidden Picture Power Point 
presentations and how they collaborate 
in their groups. They will present their 
presentations to the class. 

Note: For the completed Hidden 
Picture Power Point presentations 
and template please e-mail me and 
I will be more than happy to forward 
them to you.

H H H



“Going Tech Crazy for the U.S. Symbols” Sharon Francis
Lesson Plan No 4: Weeks 4 & 5 - talking Books & our U.S. Symbols
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n SUBJECTS COVERED 
Social Studies and Technology

n GRADES
Kindergarten - Two

n OBJECTIVES 
Students will… 

• prepare a Talking Book through 
Power Point using all the information 
they have learned during this unit to 
show mastery of the material. 

n MATERIALS 
•  Computer or Laptop

•  Interactive White Board

•  Projector

•  Internet

•  Flash drives

•  Power Point

•  Hidden Picture template (please 
e-mail me for the template)

•  Clip ar t (Microsoft Word) and 
images for www.yahoo.com

•  Discovery Education video “U.S.	
Symbols”

•  Notebooks 

•  Pencils

 

n SUNSHINE STATE 
STANDARDS 

SS.1.A.2.1 Understand history tells the 
story of people and events of other 
times and places.  

SS.1.A.2.4 Identify people from the 
past who have shown character 
ideals and principles including 
honesty, courage, and responsibility.  
Examples are Presidents, war 
veterans, community members, and 
leaders.   

SS.1.C.1.2 Give examples of people 
who have the power and authority 
to make and enforce rules and 
laws in the school and community.   
Examples are principals, teachers, 
parents, government leaders, and 
police

SS.1.C.3.2 Recognize symbols and 
individuals that represent American 
constitutional democracy.   Examples 
are United States flag, Pledge of 
Allegiance, National Anthem, Statue 
of Liberty, bald eagle, George 
Washington, Abraham Lincoln, and 
the current President.

n VOCABULARY 
Symbol, freedom, liberty, American 
flag, Liberty Bell, Statue of Liberty, Bald 
Eagle Bald Eagle, strength, freedom, 
American Flag, colonies, state,  Liberty 
Bell, Pennsylvania, England, Declaration 
of Independence,  Statue of Liberty, 
friendship, France, New York, immigrants 
Francis Scott Key, Star Spangled 
Banner, Francis Bellamy, Pledge of 
Allegiance, United States

n DIRECTIONS 
1.  On the interactive white board 

review with the students how to use 
Power Point.

2.  Review how to insert a piece of clip 
art or image, how to add text, how 
to record and insert the audio, how 
to change the color of the slides and 
how to duplicate a slide.

3.  Explain that this Power Point 
Presentation will be a group effort 
and will show what they have 
mastered.

4.  Divide the students into groups of 
four.

5.  Each group will be assigned a 
symbol of the United States. The 
Flag, Liberty Bell, Statue of Liberty 
and the Bald Eagle.

6.  Give each group a flash drive. All 
work will be saved on the flash drives 
which will be numbered 1 – 4.

7.  The groups may work on their 
projects first thing in the morning, 
during center time, during Social 
Studies and at the end of the day.

8.  Students may refer back to the 
Discovery Education video for 
reference (which is loaded on 
each computer in the room), books 
that have been introduced as well 
as their booklet Symbols of Our 
Country from www.edhelper.com.

9.  A l l ow  up  to  t wo  we eks  to 
complete.   

Note: For the completed Talking Books 
Power Point presentations and 
please e-mail me and I will be more 
than happy to forward them to you.

n EVALUATION/
ASSESSMENT 
Using the rubric that is attached the 

students will be assessed on their Power 
Point presentation. The students will 
also be given the post-test.

Note: For the completed Talking Books 
Power Point presentations please 
e-mail me and I will be more than 
happy to forward them to you.

H H H



“Going Tech Crazy for the U.S. Symbols” Sharon Francis
Future Lesson Plan Idea: Follow-Up Activity - Web Cam Book Buddies
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n SUBJECTS COVERED 
Social Studies, Reading and 
Technology

n GRADES
Kindergarten - Five

n OBJECTIVES 
Students in grade f ive will record 

themselves reading various books.

They will also use a web cam to 
communicate with the first grade 
students. 

Fifth and first grade students will work 
collaboratively.

n MATERIALS 
•  Computer or Laptop

•  Web Cam

•  Video Camcorder

•  DVR CD to Record the Video

H H H

Students using the Interactive White Board 
for their final Power Point Project
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“Going Tech Crazy for the U.S. Symbols” Sharon Francis
Lesson Plans Materials Budget

Walmart.com Flip Ultra F260 60-minute digital camcorder $109.00 1 $109.00

Walmart.com Microsoft LifeCam VX-1000 PC USB Webcam $22.32 2 $44.64

Walmart.com SanDisk 2 GB Flashdrive $9.00 4 $36.00

Sharon Francis
Snively Elementary

$189.64

$10.36

$200.00
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 Category 4 3 2 1

Group delegates 
tasks and shares 
responsibility 
effectively all of the 
time. 

Information is 
organized in a 
clear, logical 
way. It is easy to 
anticipate the type 
of material that 
might be on the 
next card. 

Project includes all 
material needed to 
gain a comfortable 
understanding of 
the topic. It is a 
highly effective 
study guide. 

Presentation 
shows 
considerable 
originality and 
inventiveness. The 
content and ideas 
are presented 
in a unique and 
interesting way. 

All content 
throughout the 
presentation is 
accurate. There 
are no factual 
errors. 

Group delegates 
tasks and shares 
responsibility 
effectively most of 
the time. 

Most information 
is organized in a 
clear, logical way. 
One card or item 
of information 
seems out of 
place. 

Project includes 
most material 
needed to gain 
a comfortable 
understanding of 
the material but is 
lacking one or two 
key elements. It is 
an adequate study 
guide. 

Presentation 
shows some 
originality and 
inventiveness. The 
content and ideas 
are presented in 
an interesting way. 

Most of the content 
is accurate but 
there is one piece 
of information 
that might be 
inaccurate. 

Group delegates 
tasks and shares 
responsibility 
effectively some of 
the time.
 
Some information 
is logically 
sequenced. An 
occasional card or 
item of information 
seems out of 
place. 

Project is missing 
more than two 
key elements. It 
would make an 
incomplete study 
guide. 

Presentation 
shows an attempt 
at originality and 
inventiveness on 
1-2 cards. 

The content is 
generally accurate, 
but one piece 
of information is 
clearly flawed or 
inaccurate. 

Cooperation 

Sequencing 
of Information 

effectiveness 

originality 

Content - 
Accuracy 

Group often is 
not effective in 
delegating tasks 
and/or sharing 
responsibility.
 
There is no clear 
plan for the 
organization of 
information. 

Project is lacking 
several key 
elements and has 
inaccuracies that 
make it a poor 
study guide. 

Presentation is a 
rehash of other 
people’s ideas 
and/or graphics 
and shows very 
little attempt at 
original thought. 

Content is typically 
confusing or 
contains more than 
one factual error. 

Score
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“Going Tech Crazy for the U.S. Symbols” Sharon Francis
Rubric

PowerPoint Appearance and Content: Talking Books and our U.S. Symbols
 
Teacher Name:            

Student Name:             

Total Score  
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“Going Tech Crazy for the U.S. Symbols” Sharon Francis
Additional Information & Worksheets

Bald Eagle    American Flag

Liberty Bell   Statue of Liberty

Francis Scott Key   Francis Bellamy

George Washington   Benjamin Franklin

Lesson 1 – Week 1: Symbol? What’s a Symbol?
Word Wall Cards using Microsoft Word and images from www.yahoo.com



White House   United States

England   France

Immigrants  Pennsylvania

Declaration of

Independence   New York

Uncle Sam
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“Going Tech Crazy for the U.S. Symbols” Sharon Francis
Additional Information & Worksheets

Lesson 1 – Week 1: Symbol? What’s a Symbol? (cont.)
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“Going Tech Crazy for the U.S. Symbols” Sharon Francis
Additional Information & Worksheets

  Match the U.S. symbol to the correct word.

Name              Date   

Pre/Post-Test – Use in Lesson 1 & at end of Unit

Bald Eagle

Statue of Liberty

United States Flag

 
Liberty Bell
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“Going Tech Crazy for the U.S. Symbols” Sharon Francis
Additional Information & Worksheets

1. What country gave us the Statue of Liberty? 

a.)  Italy 

b.)  China 

c.)   France 

2.  In what state is the Liberty Bell? 

a.)  Pennsylvania 

b.)  Alabama 

c.)   New York 

3.  Who wrote the Pledge of Allegiance? 

a.)  Benjamin Franklin 

b.)  Francis Bellamy 

c.)   George Washington

 

4.  What does the Bald Eagle stand for? 

a.)  fear 

b.)  strength 

c.)   sadness 

5.  Where was the Statue of Liberty put together? 

a.)  France 

b.)  New York 

c.)   Pennsylvania 

6.  Who wanted the turkey to be our national bird? 

a.)  Francis Bellamy 

b.)  Abraham Lincoln 

c.)   Benjamin Franklin 

7. What three colors are found in the American flag? 

a.)  red, white, and blue 

b.)  red, white, and green 

c.)   red, white, and yellow 

8.  On July 8, 1776 the Liberty Bell was rang for the first time. 
What did people come to hear? 

a.)  George Washington tell them a story 

b.)  To hear the Declaration of Independence 

c.)   To hear the Star Spangled Banner 

9. Who wrote the Star Spangled Banner? 

a.)  George Washington 

b.)  Francis Bellamy 

c.)   Francis Scott Key 

10.  Who was the first president of the United States? 

a.)  Benjamin Franklin 

b.)  George Washington 

c.)   Francis Scott Key 

11.  In what year did the Statue of Liberty arrive in the United 
States? 

a.)  1885 

b.)  1995 

c.)   1785 

12.  About how tall is the Statue of Liberty? 

a.)  100 feet 

b.)  300 feet 

c.)   500 feet 

13.  What do the thirteen stripes represent on the flag? 

a.)  thirteen presidents 

b.)  the thirteen original colonies 

c.)   the thirteen biggest states 

14.  Who was Samuel Watson? 

a.)  The man Uncle Sam is based on 

b.)  George Washington’s uncle 

c.)   The thirteenth president 

15.  Why is the White House a symbol of America? 

 a.)  it is a very big house 

 b.)  it is where the president lives 

 c.)  it is very old

Choose the correct answer to each question.
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Pattern to Make Uncle Sam hats
Pattern found at: http://www.leehansen.com/coloring/Costume/images/uncle-sam-hatclr.gif
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I pledge allegiance

to the flag

of the United States of America

and to the republic

for which it stands,

one nation,

under God,

indivisible,

with liberty

and justice for all.

Lesson 2 – Week 2: Can You Hear Me MP3?

Name          Date     
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Lesson 2 – Week 2

Name          Date     

Pledge of Allegiance Reading Fluency Log

 Date Number of Words Read Time
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Video
 U.S. Symbols
  http://streaming.discoveryeducation.com/index.cfm

 Uncle Sam – Video Clip from Celebrating America: Symbols and Ceremonies of the United States
  http://streaming.discoveryeducation.com/index.cfm

Booklet 
 Symbols of Our Country 
  www.edhelper.com

Books
 “Our	Flag”  Harcourt Time Readers For Kids written by Joanne Randolph

 “The	Statue	of	Liberty”	Harcourt Time Readers For Kids written by Elena Martin

 “I	Pledge	Allegiance” written by Bill Martin Jr. and Michael Sampson

Uncle Sam Hat Pattern
 http://www.leehansen.com/coloring/Costume/images/uncle-sam-hatclr.gif


